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  CAPITULO 1 

Conceptos Básicos que deben ser tomados en cuenta: 

a) Software de aplicación: (Primero conecte el Modem y Asegurese que el led 

verde/amarillo del modem este parpadeando antes de correr la aplicación ) al 

conectar el modem, demóra entre 10-20 segundos. 

Programa que Administra y da mantenimiento a los registros (Se requiere Modem y SIM   conectados al 

puerto USB de su computadora.)  Si los mismos no son detectados la aplicación no se abrirá. 

     

b) SIM del Proveedor: 

Es el Chip que guarda el número telefónico de su proveedor    (Se requiere que este activo y con saldo 
disponible). Generalmente el Numero de PIN viene Inactivo,  SI el PIN esta activo dentro del SIM el 
modem NO podrá registrarse en la red de Telefonia.  Verifique el nivel de señal recibido por el modem, 
ver pagina 18 del Manual de Instalación para su referencia. Y pagina 47 de este Manual de Uso para 

mas detalle.  

  

c) IMEI        

El IMEI (International Mobile Equipment Identity, Identidad Internacional de Equipo Móvil) es un código 
pre-grabado en el Modem.  Este código identifica al aparato a nivel mundial, y es transmitido por el 
aparato a la red al conectarse a ésta.  SE SUGIERE COPIAR ESTE NUMERO EN UN LUGAR  SEGURO. Para 

posteriores referencias ( el IMEI del modem se encuentra en la parte posterior del mismo) 

d) Longitud del SMS  

Un SMS en formato Normal le permite hasta 160 caracteres. * Si desea enviar SMS de más de 160 

Caracteres, Por favor vea la nota correspondiente en la pagina 48 bajo el tema Configuraciones. 

El uso de “Variables” dentro del SMS afecta +/- el largo final del SMS. 

Un SMS en formato UNICODE ( Permite caracteres especiales tales como ñ, Ñ y vocales tildadas, y su 

longitud es de 70 caracteres)  
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CAPITULO 2 

Address Book o Libro de Contactos 
 

Esto lo encuentra en la viñeta              y se utiliza para todo el 

mantenimiento de contactos y Grupos de contactos.  

1. Creación, Modificación y eliminación  de Contactos 

 

Utilice el icono   

Se recomienda limpiar el formulario antes de cada creación.    

 

� Ingrese  la información  

 

 
La capacidad máxima del Campo Full Name es de 18 CARACTERES,  si se pasa de 18 

caracters el sistema truncara donde encuentre el primer espacio al momento de enviar la 

variable “Recipient’s Name” dentro del cuerpo del SMS. 

 El Campo First Name tiene prioridad sobre Full 

Name, al momento de invocar la variable Recipient’s Name. Si First Name esta vacio se 

tomará la información de Full Name. 
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La capacidad máxima de los Campos Remarks1,2 y 3 es de 13 CARACTERES,  si se pasa de 

13 caracters el sistema truncará donde encuentre el primer espacio al momento de enviar 

las variables  “Remarks 1,2 o 3” dentro del cuerpo del SMS 

 
 

� Para grabar presione     

� Para modificar un contacto existente, seleccione su contacto 

 

 

� modifique los datos necesarios y luego presione               

 

 

� Si desea eliminar un contacto, seleccionelo y presione        

 

Busqueda de contactos Presione                                                      

Con esta opcion entra al motor de busqueda (Pagina 48 para ver el uso de esta herramienta)  

con el cual puede hacer una selección especifica.  
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2. Creación, Modificación y eliminación  de Grupos de contactos.  

 

Utilizando el icono    puede Crear Grupos de contactos. 

Utilice la misma metodología para la creación de contactos.  
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�  

Al borrar o eliminar un Grupo tiene opción de borrar juntamente los contactos que tiene relacionados 

                                           

Después de crear uno o varios Grupos, puede definir a que grupo pertenecen los contactos.   

� Primeramente seleccionando el Grupo deseado 

� Actualizando el registro Presionando Update Contact  

Eje: 

 

En la parte inferior izquierda del modulo de contactos tiene la opción para seleccionar “Todos” los 

contactos.     

Para hacer búsquedas de contactos utilice el botón de     una explicación mas amplia la 

puede encontrar  en la sección “Motor de Búsqueda… ver Pagina No. 48” 
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Exportación de Address Book: 
Esta opción le permite exportar su lista de contactos con sus respectivos Grupos.  Seleccione la 

secuencia File > Exportar Address Book. 

                             

Seguidamente puede seleccionar los campos que desea exportar como por ejemplo (Full name, Mobile 

number etc) además deberá indicar la ruta donde desea depositar el archivo. 

Existen dos formatos de exportación:  Archivo texto delimitado por comas CSV o en formato Excel XLS. 

Si desea incluir a que Grupo pertenece el contacto, seleccione . 

Finalmente presione el botón de  para generar el archivo.  Un mensaje de finalización le 

aparecerá. 

                                                            

En formato de Excel le quedara así:  

 

En archivo Texto Delimitado por comas le quedara así: 
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Importación  de Address Book: 

  

Como primer paso, debe definir en la opción Tools>configuration Settings>Address Book>Deafult 

Import Address Book Delimiter, el formato default que Smarttalk utilizará para la importación.        

 

Esta opción le permite agregar contactos desde un archivo de Excel o Texto Delimitado por comas o 

Texto Tabulado. 

Debe seguir la secuencia File > Importar  Address Book. 

Le pedirá abrir el archivo origen: 

 

En el cuadro de diálogo Importar Address Book , busque y seleccione el campo correcto de cada 
columna. Si no selecciona un nombre de campo sobre la columna, esa columna en particular no se 
importará. Para finalizar presione el botón de IMPORT  * Importante, los campos obligatorios son Full 
Name y Mobile Number. 
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Si una de la columna de su base de datos contiene el nombre del grupo de contacto, puede seleccionar 

la opción “Grupo de contacto” para esa columna. Para los contactos que son miembros de múltiples 

grupos de contacto, los nombres están separados por punto y coma dentro de la columna. 

Posteriormente le aparecerá la siguiente imagen, donde se le indica que contactos están listos para ser 

agregados al Address Book (Passed Contacts)  y cuales NO serán agregados (Failed Contacts). Presione 

en botón de  para terminar.  

 

Ejemplo de cuando la información NO es aceptada para ser agregada al address book. 
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Para el formato CSV el formato deberá ser así: 

 

Este ejemplo contempla los primeros 4 campos y el Grupo a que pertenecerán 

� Siga los mismos pasos para la opción de Excel.  

 

Creación de Grupo Virtual: 
 

Esta opción le permite crear un Grupo Virtual para el envío de SMS a un Rango de números de Móviles 

y/o Posibles Contactos.  Puede acceder con la secuencia Tools > Generate Virtual Group. 

                               

Ingrese el nombre nuevo del Grupo, una descripción (Opcional) y los 2 datos iniciales de números a 

enviar (obligatorios) Rangos. 

Basicamente lo que hace esta opción es crear un rango de números consecutivos a partir de los datos 

que le pide (Starting Number y Ending Number)  eje: 
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Starting Number = 49000001 and Ending Number = 49000025. Para este caso el sistema creara 25 

nuevos contactos  llamados Virtual_userX  que estarán en el Address Book > contacts 

 

Si se envía un SMS o Campaña a este Grupo, el sistema le enviara a la red de Telefonía, un lote de 25 

SMS.  Los SMS serán entregados de acuerdo a cuantos números de ese rango estén activos en la red. 

� El número máximo para esta opción es de 1000 números.  

� El mantenimiento para esta clase de Grupo Virtual es el mismo que para un Grupo Normal. 

                                                    CAPITULO 3 

3. Envío de SMS.  

Existen 3 vías para el envío de SMS 

� Envío Rápido 

� Envío por el Scheduler o programado  ** 

� Envío por el Event Manager (basado en alguna fecha del Address Book). ** 

** LA COMPUTADORA NO DEBE ENTRAR EN MODO DE SLEEP (SUSPENDER) Y/O HIBERNAR 

(HIBERNATE) YA QUE ESTAS OPCIONES INPIDEN EL ENVIO de SMSs. 

a) Envío Rápido: 

Para poder enviar SMS puede acceder con la secuencia Tools > Send SMS  o bien presionando el icono: 

  

 

Para abortar un envio de SMS que ya iniciado, deberá desconectar el modem del puerto USB y cerrar la 
aplicación.  Si desea solo pausar para después continuar dirigase a Tools -> Real Time traffic Monitor y 

utilice los botones Pause and Resume 
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Para ambos casos le mostrara la siguiente imagen:

 

Recipients = Uno o Varios Grupos, uno o varios Contactos o la combinación de ambos. 

Advanced = Herramienta para hacer una selección mas especifica ( Ver Motor de búsqueda.Pag 48) 

Message = Cuerpo del Mensaje (con el botón derecho del mouse puede insertar Templates o algunos 
campos del Address Book que pueden servir para “Personalizar” el mensaje.) también puede agregar 

un link de algún web Site por ejemplo: http://www.smarttalksms.com 

Message Type =  Recuerde que un SMS Normal Text = 160 Caracteres y UNICODE = 70 Caracteres. 

Priority = Prioridad al momento del Envío ( Normal y High priority). Los mensajes con alta 

prioridad serán enviados antes de los mensajes normales.  
 

                                          
 

Presione Send para enviar el o los SMS 

Si la sección de Recipients o Message  esta vacía al momento de presionar Send, le mostrara la 

siguiente imagen: 
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b) Envío por el Scheduler o Programador:   

 

AEGURESE QUE SU COMPUTADORA NO ENTRE EN MODO DE SUSPENDER (SLEEP), HIBERNAR 

(HIBERNATE) YA QUE ESTAS MODALIDADES  INPIDEN  EL ENVIO DE UNA CAMPAÑA , POR MEDIO 

DE LA OPCION SCHEDULER Y/O EVENT MANAGER. 

 

 

Con esta opción usted podrá programar en una fecha y hora determinada a futuro el envío de uno o 

varios SMS a uno o  varios Grupos, uno o varios Contactos o la combinación de ambos. 

Ingrese los datos necesarios como lo muestra la siguiente imagen: 
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Al programar un nuevo Schedule el  campo Status estará en Active   

Cuando sea finalizado el Schedule el Status cambiara a Completed    

Un schedule luego de cumplir la fecha en la cual se programó, cambiara su status a “completed”. Este 
status determina únicamente si la fecha en la cual se programó dicho Schedule ha caducado o no. En 
ningún momento significaría que el Schedule ha sido enviado en su totalidad. Para saber si el Schedule 

ha sido enviado se verificara en el Transaction Manager. 

PARA CUALQUIER APLICACIÓN PROGRAMADA, EL PROGRAMA TIENE QUE ESTAR ABIERTO, YA SEA 
MINIMIZADO O NO, Y NUNCA CERRADO; DE LO CONTRARIO ESA PROGRAMACION CUMPLIRA CON SU 

FECHA PERO NO SERA ENVIADA.  

 

En el contenido del mensaje puede utilizar algún Template pre definido y/o Variables tales como: 
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Ejemplo: 

 

El SMS será visualizado de la siguiente manera: 

 

Los datos de las variables << SpecificDate>>  y  <<SpecificTime>> son tomados de los ingresados en la 

sección  Schedule Date 
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Si se tiene un intervalo regular en el scheduler, la duración del “Start Date/Time” y el “End Date/Time” 

tiene que durar lo mismo que dure el intervalo de tiempo. (Por ejemplo si es un día  tiene que durar 1 

día, si es una semana tiene que estar establecido por toda una semana, etc.) 

 

Con el botón de    puede visualizar la calendarización de actividades (Activas y completadas) 

 

c) Envío por el Event Manager:   

Con esta opción se puede programar envíos de SMS, en base a una fecha establecida o bien en base a 3 

campos del address Book Date Of Birth, Remarks 4 y Remarks 5 que son de tipo fecha.  
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Ejemplo de ingreso de datos: 

 

� El mantenimiento de los eventos es similar al de Grupos, Contactos,Scheduler.  

 

Para que un evento se pueda ejecutar es necesario que el event Status este Active 

 

Si desea suspenderlo pero no quiere borrarlo actualice el evento poniendo el Status en Suspend 

seguido de Update Event 

       

� El periodo en el Event Timing Information  puede ser Anualmente o Mensualmente  
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4. Creación de Template o Plantilla.  

Esta opción le permite la creación de un SMS pre definido para uso posterior. Son modelos de mensajes 

que usa con frecuencia y que puede dejarlo almacenado. 

 

                                                  

 

Puede usar uno  o varios  template (Plantillas), en cualquier opción de envío . 

Utilizando la opción Insert Template ( presionando botón derecho del mouse) .  
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5. Campaign Manager.  

 

El administrador de campañas del Smart Talk permite al usuario crear campañas de envíos de  SMS para 

votaciones, concursos o encuestas. Con el administrador de campaña, puede crear su propia campaña 

para consolidar reacciones de sms o encuestas en la forma de representación gráfica. 

Esta opción le permite, parametrizar variables  (Available Options) que UD. espera que el contacto que 

recibe un SMS, le devuelva una de esas posibles  respuestas. Las Acciones de cada Variable deben ser 

definidas y parametrizadas en el Modulo de Auto Response System 

Lo más importante de esta sección son las posibles variables de respuestas que se definan. 

Se recomienda que para cada campaña utilice variables diferentes para no entorpecer el proceso de 

graficas.  

Ejemplo: 

Una encuesta: Ud. Desea saber que piensan sus contactos  acerca de un equipo de futbol, la pregunta 

podría ser:   Cree Ud. que el Equipo X será campeón en esta temporada?   

Responda A1 = SI, A2 = NO, A3 = QUIZA. 

Entonces deberá definir que la campaña contiene las variables A1,A2,A3  

(Cada variable recibida, tendrá una ejecución especifica que se parametrizará en el modulo de AUTO 

RESPONSE SYSTEM)  * Es importante destacar que el Modulo de Campaign Manager va 

estrechamente relacionado con el modulo de Auto Response System  

                                   

� Con la opción Clear All Options, limpia la definición de las variables. 
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Utilice: 

 

 Add Campaign       para grabar una nueva campaña. 

Delete Campaign  para eliminar o borrar  una  campaña. 

Update Campaign para modificar o actualizar  una  campaña. 

Clear entries           para limpiar todos los datos de una  campaña. 

View Result            para visualizar  en tiempo real los resultados de la campaña asi como la grafica. 

 

 

6. Auto Response System. 

 

El sistema automático de respuesta de Smart Talk (ARS) permite al usuario crear reglas que coincidan 

con un patrón de mensaje. Cuando Smart Talk reciba un mensaje, ARS buscará las coincidencias de 

acuerdo a las reglas de la base de datos sobre el contenido del mensaje. 

En esta sección podrá definir las reglas de las variables (Definidas en la Campaign Manager) que 

deberán ejecutar alguna acción al momento de recibir el SMS. 

Rule Name: Nombre de Regla o Variable, debe ser igual a la que se definió en el Campaign Manager 

Status: Parametrizacion de la Regla (Activa o Suspend) 

Condition Sender:  Se utiliza para definir quienes pueden enviar respuestas, por default es ALL (Include 

those not in Address Book), pero si desea aplicar un filtro para que uno o varios Grupos sean los validos 

o  una selección de contacts, entonces utilice alguna de las opciones. (Sender Type) 
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Ejemplo: escogiendo ALL le mostrara la siguiente imagen: 

                

Si desea una selección mas especifica utilice el motor de búsqueda, presionando Advanced… 

Si desea quitar o agregar contactos presione nuevamente el botón Sender …  

Message Patern: 

Aquí se definen las posibles formas de cómo la respuesta puede ser recibida, (incluyendo mayúsculas y 

minúsculas)  

Begin with:  Caracteres Iniciales  que serán tomados como validos en el SMS de Respuesta. 

Ends with:  Caracteres finales que serán tomados como validos en el SMS de Respuesta. NO APLICA A 

LA OPCION SMS Vote/Contest/Survey, ya que para la misma se requieren variables “exactas” 

Contains: Posibles variaciones de la respuesta del SMS (debes ser separadas por punto y coma “;”) y 

que las mismas sean buscadas dentro del cuerpo de la respuestas Eje: ( “Mi respuesta es Co1”)  

                        

Acciones:  

Cuando se recibe un SMS como respuesta, el sistema la validara de acuerdo al Patrón definido y si 

cumple positivamente, entonces ejecutara alguna de las siguientes acciones: 

Auto Replay to Sender: 

Auto contestación para el Remitente. 
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Esto significa que cuando se reciba una respuesta valida  el sistema automáticamente generará un SMS 

que será enviado al  remitente que envío dicha respuesta. Puede agregar variables con el botón 

derecho del mouse. 

                                            

Forward to Selected Recipients: 

Enviar copia del SMS de Respuesta a otro contacto y/o Grupo de contactos. 

Con esta opción se puede hacer que cuando se reciba una respuesta valida que cumpla con el patrón, 

se genere un SMS y se envíe a otro Contacto o Grupo que este interesado en la respuesta.  

                                      

� Se pueden utilizar en el Header o encabezado del SMS las Variables o etiquetas Número del 

contacto y nombre del contacto. Y el Footer como complemento o extensión del SMS 

Invoke External Application: 

Invocar una aplicación externa. 

Esta opción le permite ejecutar alguna aplicación automáticamente al recibir un SMS de Respuesta 

valido.   

                                       

Automatic shutdown: 

Cierre de Sesión/Reinicio de la computadora/ Apagado de la computadora. 
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Esta opción le permite ejecutar las siguientes instrucciones en la computadora donde esta corriendo 

Smart Talk. ( si desea que SmartTalk se inicie al momento de escoger Reboot, deberá parametrizarlo en 

las opciones de all programs > StarUp o Inicio de su sistema Operativo) 

                                   

 

Export to Text Document: 

Exportación de Documento en formato Texto. 

Esta opción le permite ir almacenando las respuestas recibidas en un archivo de Texto.  

                                

 Los SMS entrantes se pueden guardar en un archivo de texto cuando se selecciona esta opción. El 
archivo de texto almacenará el número de teléfono móvil del remitente, el nombre y el contenido del 
mensaje. Puede seleccionar el directorio donde usted desea guardar. El nombre del archivo para el 
documento de texto estará como MoCoLogDDMMYY.txt.   
Donde: 
DD – día  
MM – mes  
YY – año  
Al crear diferentes reglas para exportar al documento de texto, puede especificar otro directorio por lo 

que cada regla se guarda en un archivo diferente. 

Ejemplo del archivo Texto 
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SMS Suscription: 

Activación o Desactivación de Contacto 

Este parámetro se utiliza en la definición de contactos del Address Book, y  consiste en determinar si un 

contacto esta activo (YES o en blanco) e Inactivo (NO) 

Utilizando esta acción en la regla, logra cambiarle el Status al contacto,  La llave de búsqueda en el 

Address Book es el Mobile Number 

               

 

� Al estar un contacto con Status de SMS subscription = NO, el mismo  No podra recibir SMS  

 

Register contact: 

Registrar Contacto Nuevo 

Seleccione esta opción para registrar un contacto nuevo en la libreta de direcciones. En un ejemplo, si 
la condición de remitente es “Todos” y el patrón (Regla)  de mensaje es  ‘Registrar’”, y un sms entrante 
se recibe con el contenido:  
 
Registrar, Julio Diaz,12345678,Jdiaz@Yahoo.com,12/25/1970 

 
Se guardará automáticamente la información del contacto en el Address Book o libreta de direcciones. 
Esta acción es útil para registros automáticos de membrecías.  
Es importante definir el delimitador entre los campos (Eje: Comas, Tab etc.) 
 

 

� En la accion Register Contact el primer campo se deja en blanco, porque es la regla a identificar 

� Campos Obligatorios: FULLNAME y MOBILE NUMBER (maximo 4 campos a capturar) 

� El formato para los campos Date Of Birth, Remarks4, Remark5 debe ser MM/DD/YYYY 
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Confirm/Cancel Appointment: 

Confirmar o Cancelar Citas: 

Seleccione esta opción para confirmar / cancelar citas. Si un sms entrante coincide con el patrón y 
condiciones del remitente y del mensaje, Smart Talk buscará “nombre de la cita” dentro del contenido 
del mensaje y realizará la confirmación / cancelación de la cita automáticamente.  
Por ejemplo, digamos que una regla es creada de tal manera que la condición del remitente es “Todos”, 
y la condición del patrón del mensaje es “Empezar con: confirmar”, y la acción seleccionada es 
“Confirmar/cancelar cita”  

Se recibe un sms con el contenido:  “confirmar 007” 
Desde el momento en que el remitente y el patrón del mensaje coinciden, la acción será 

“confirmar/cancelar cita”. Smart Talk, buscará una cita o Appointment con el nombre “007” y la 

establecerá en el estado del remitente como “Confirmado 
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SMS Vote/Contest/Survey:  

SMS votar/concurso/encuesta 

Esta opcion se utiliza para parametrizar respuestas que seran Graficadas en la opcion de VIEW RESULT 

del Modulo de Campaign Manager. . Es importante destacar que debe asegurarse que el 

nombre puesto debe ser “EXACTAMENTE” igual a como de definió en el  modulo Campaign Manager de 

lo contrario la informacion recibida no será graficada.             
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Information Retrieval:  

Esta opcion sirve para hacer un merge a un archivo externo (eje: una Hoja de Excel) y en base a las 

reglas y variables que se reciban en el SMS, estos puedan abrir el archivo buscar encabezados y tomar 

alguna data de dicha hoja y responder al remitente 

Ejemplo: Hoja de Excel donde se encuentran las calificaciones de un grupo de Alumnos.  

Parámetros:  
• Archivo MS Excel – especificar la ruta completa del documento para recuperar información desde MS 
Excel.  

• Hoja de cálculo – especifique el nombre de la hoja de cálculo en el documento de Excel. 

Datos dentro de la Hoja de Excel. 

 • Coincida la columna A con – especificar qué palabra dentro del mensaje sms debe coincidir con la 
columna A de la hoja de cálculo de Microsoft Excel. Puede optar por hacer que coincida el número de 
móvil del remitente.  
• Coincida la columna B con – especificar qué palabra dentro del mensaje sms debe coincidir con la 
columna B de la hoja de cálculo Microsoft Excel. Puede optar por hacer que coincida el número de 
móvil del remitente.  
•Número de columna para su recuperación – el número de columna del campo que va a recuperarse. La 
columna A corresponde a la columna 1.  
•Encabezado de mensaje opcional – encabezado del mensaje de respuesta.  
Para una mejor ilustración, pensemos que la hoja de cálculo de Excel “TestResult.xls” contiene el 

siguiente contenido: 

 

Ahora, digamos que creamos una regla cuya condición de remitente está establecida como “Todos” y la 
condición del patrón del mensaje como  que Inicie  con  “ promedio” y una acción de “recuperación de 
información” tal y como se muestra en el ejemplo de arriba.  
Imagine que entra un SMS del número +6593334444, con el siguiente contenido:  
“promedio S7533344Z”  
Este SMS entrante coincidirá tanto con las condiciones de patrón del remitente como del mensaje. Por 
lo tanto, se activará la acción de “recuperación de información”.  
Smart Talk buscará la coincidencia entre la columna A de la hoja de cálculo con la segunda palabra del 
mensaje (S7533344Z) y la columna B de la hoja de cálculo con el número del remitente (+6593334444).  
Cuando es un registro que coincide, Smart Talk recuperará el registro de la columna 7 (el valor 91) y 
responderá el siguiente valor al remitente:  

“el Calificación es: 91” 
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Visualizacion de Resultados de una Campaña 
 

Una vez se que se reciban respuestas con reglas relacionadas a una campaña, puede visualizar las 

graficas en la opcion de VIEW RESULT del Modulo de Campaign Manager.  

                                    

 

Existen 2 tipos de Graficas  tipo Pie y tipo Barras 
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Al recibir una respuesta valida, el sistema lo parametriza como Voto Valido, pero si por alguna razon 

usted desea cambiarle el Status a Voto Invalido,  seleccione el registro al inicio y presione el boton 

derecho del Mouse.  Si una respuesta no hace Match con los parametros establecidos, si será recibido 

(Transaction Manager) pero no será tomado como Registro Valido para los datos estadisticos.  

 

 

Le aparecera la siguiente imagen: 

 

Y escoga la opcion deseada.  

 

 

En la seccion de Resumen  (Summary Information)  usted puede escoger 2 opciones: 

1. Enviar SMS a los participantes ( Por ejemplo: un SMS de Agradecimiento) 

2. Seleccionar un Ganador de forma Random ( o al azar)  

Esto lo logra posicionandose al principio de los registros de la seccion Option Name y presionando el 

boton derecho del Mouse. 
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Si escoge la primera opcion se le mostrara la siguiente imagen:

 

Redacte el mensaje que desea enviar ( el sistema automaticamente asignara el numero del Recipiente) 

y presione Send 

Si escoge la opcion de Select winner (Seleccione un ganador) se le mostrara la siguiente imagen 
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Donde podra escoger dentro de la List of  Mobile Number 1 o más ganadores, esto lo define en la 

casilla Number of winners, despues presione Pick Winner y el sistema le escogera en formar aleatoria 

uno o mas ganadores y poniendolos en la seccion Winners,  posteriormente puede redactar el mensaje 

de aviso (si desea utilize las variables disponibles con el boton deecho del Mouse)  y presione Send SMS 

to Winners. 

� Si desea exportar la informacion del ganador o ganadores, seleccione Save Result y el sistema le 

generara un archivo en formato Texto. 

 

Exportacion de Resultados: 

Los resultado graficados pueden ser exportados en 3 formatos: 

� Texto 

� Excel 

� HTML 
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Otras opciones: 

Existen 2 parametros que se pueden modificar de acuerdo a sus requerimientos. 

 

Ignore Duplicated votes:  esto filtra SMS que sean del mismo numero, de tal manera que solo deja 1 

Voto Valido. 

Automatically refresh results:  esta opcion siempre esta activa y sirve para que el sistema grafique de  

forma instantanea los registros que se reciben en tiempo real. 

 

7. Appointment Book o Agenda de Citas.    

 

Con la agenda de citas de Smart Talk, el usuario poder programar sus citas y enviar SMS de recordatorio 
a los destinatarios seleccionados. Una vez que el destinatario recibe el recordatorio SMS, pueden 
responder a través de un SMS a Smart Talk para la confirmar o Cancelar la cita instantáneamente.  
.  
La agenda de citas incluye:  
• Agregar, eliminar y actualizar citas  
• Vista de calendario mensual, semanal o vista diaria  
• Vista de respuesta (Confirmación o Cancelacion automática de cita)  Graficas  
• Ver historial de citas  

• Importación de citas desde archivo csv 

a) Creación de un agenda nueva. 

Como primer paso, deberá crear el nuevo Appointment Book o Agenda, para ello debe ir a la 

secuencia, Tools >  Configuration Settings > Appointment Book>Multi-App Book Configuration. 

  

Ingrese el nombre de su nueva agenda (Perfil) o Appointment Book y presione el botón  
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b )  Creación de un nuevo appointment o Cita.  

IMPORTANTE: El recordatorio de citas debe ser 1 dia antes del evento. EL SISTEMA no envía SMS 
de recordatorios el mismo dia el evento (eje: Citas del viernes = recordatorios dia Jueves) 

1. Escoja el perfil (Appt Book)  del Appointment Book. 

                                                                          

2. Presione doble click en la fecha del calendario que aparece en la pantalla para crear los 

parámetros de la cita. Aparecerá un cuadro de diálogo para agregar la nueva cita. 
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Ingreso de Datos: 

 

 

• Appointment name: Nombre de la cita – este se utilizará para confirmar la cita cuando 
el destinatario responda con un mensaje SMS. Si se establece la configuración para 
ingresar automáticamente el nombre de la cita, el mismo será completado por Smart 
Talk. (Este nombre deberá ser parte del SMS de respuesta )  Eje “Confirmar App1” para 
Confirmaciones y “Cancelar App1” para Cancelaciones. Donde Confirmar y Cancelar 
serán variables a definir en el ARS (Auto Response System)  ver Detalle Pag. 35 y App1 
es el nombre del Appointment a ser afectado. 

• Priority  - Prioridad – se puede seleccionar desde baja, media, alta y muy alta. La 

prioridad aparecerá resaltada con un color de acuerdo al tema de la cita cuando lo 

observe en el calendario principal. Las citas que tienen prioridad baja o media, serán 

tratadas como mensajes normales al momento de su envío. Las citas que tienen 

prioridad alta y muy alta serán tratadas como mensaje de alta prioridad al momento de 

su envío. 

• Subject - Tema – una breve descripción de la cita. Se mostrará el texto del asunto en el 

calendario principal. 

• Start time/ End Time - Hora de inicio / término – hora de inicio y hora de término de la 
cita. Tenga en cuenta que la hora de inicio de la cita puede ingresarse automáticamente 
en el contenido del mensaje SMS mediante la etiqueta << App time >>.  

• Remarks - observaciones – observaciones adicionales (opcional). 

• SMS Reminder – Con esta casilla habilita la opción para ingresar los contactos o 

Grupos a quienes va dirigido el recordatorio. Puede utilizar la búsqueda avanzada 

presionando Advanced. 

• 1st,2nd,3rd SMS Reminder  Ingrese los datos deseados tales como:  Hora preferida de 

envío, días anticipados a la cita, y el mensaje a enviar (puede utilizar plantilla si desea) 
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NO SE PERMITE HACER UN REMINDER EL MISMO DIA DEL APPOINTMENT (Min 1 dia 

antes) 

 

• Response:  herramienta para visualizar en forma de Graficas las confirmaciones y/o 
Cancelaciones  de una Cita.  Es necesario que las variables Confirmar o Cancelar esten 
definidas como Regla en el modulo de Auto Response System y utilzando la Action 
Type  de Confirm/Cancel Appointment  
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• Day View:  Herramienta para visualizar en forma de calendario los Datos de las citas. 

 

  

Las Opciones: View Selection  le permite ver de forma grafica el Calendario de Citas en forma Semanal 

o Mensual 

 

 

En Appointment Book, puede escoger una agenda especifica y generar un listado histórico de las citas 

generadas, presionando el botón  el mismo lo puede exportar a TXT. 

 

Presionando Search inicia el reporte.  

                                 

 

Importar listado de citas  
 

 
 
Paso 1: Aparecerá un cuadro de diálogo para que usted cargue al archivo a esta lista de citas. Smart Talk 

espera un csv (valores separados por coma) para importar la cita. 
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Un archivo típico de importación de citas (*.csv) debe contener los siguientes campos (no en cualquier 
orden):  
• Nombre del cliente  
• Número de móvil del cliente  
• Hora de inicio de la cita (en formato de 24 horas HH: MM)  
• Nombre de la agenda de citas (opcional)  
• Duración de la cita en minutos (Opcional)  
Todos los registros dentro de un mismo archivo de importación deben pertenecer a la misma fecha de 
cita. Cada uno de estos campos estarán separados por comas y cada registro separado por un envío de 
retorno.  
Paso 2: al seleccionar el archivo de importación de cita (*.csv), aparecerá un cuadro de diálogo como se 

muestra a continuación, mostrando todas las columnas dentro del archivo de importación. 
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Paso 3: Seleccione los nombres de campo (ej. Nombre del destinatario, nombre de la agenda de citas, 
etc.) Para las columnas que desea importar.  
Paso 4: En la parte de la izquierda de “Información general de la cita”, escriba lo siguiente:  
• Fecha de la cita – la fecha de la cita para las que se van a importar.  
• Prioridad predeterminada – nivel de prioridad de las citas a ser importadas. Puede utilizar el valor 
predeterminado.  
• Duración – la duración de la cita en minutos. Si su archivo de importación de citas no tiene ninguna 
información sobre la duración de la misma, puede establecer una duración estándar para todas las citas 
que se importarán.  
• Hora preferida para SMS – el tiempo y el número de días/semanas que usted desee enviar por SMS 
antes de la cita.  
• Tipo de mensaje – selección de texto normal, 8-Bit de datos o Unicode (texto chino). Para contenido 
normal en inglés, utilice texto normal. Si el mensaje contiene caracteres chinos, utilice Unicode.  
• contenido del mensaje – el contenido que se enviará a través de SMS. Puede insertar una plantilla o 
escriba en el texto directamente.  
Paso 5: Debajo de “registro del proceso de importación”, puede guardar un informe sobre el proceso de 
comprobación de importación al seleccionar “guardar informe del proceso de importación”. También 
puede especificar la carpeta que desea para guardar el informe de proceso de importación.  
Paso 6: Una vez que se revisa toda la información y se comprueba que sea correcta, usted puede hacer 
clic en “importar” para proceder con el proceso.  

Al importarse con éxito, verá el siguiente mensaje. 

 

8. Transaction Manager  o Manejador de Transacciones.    

 

El administrador de transacciones de Smart Talk realiza un seguimiento de todos los SMS entrantes y 
salientes. Las transacciones pueden ser rastreadas y buscadas utilizando la consulta de búsqueda en el 
administrador de transacciones. Registros de transacciones también pueden ser incluidos en un archivo 
de informe presionando el botón Generar Informe.  
 
Las funciones del administrador de transacciones incluyen:  
 
• Búsqueda fácil y flexible en la base de datos de transacciones  
• Generar informe de transacciones en la búsqueda de resultados  

• Administración de los registros de transacciones 

Este modulo se divide en 3 secciones:  Inbox ( SMS entrantes) Outbox (SMS Salientes) y Transaction 

Records Query. Una vez tenga datos necesarios para la búsqueda, presionar  Search   esta 

aplicara tanto para la bandeja Inbox como Outbox 
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� Puede seleccionar registros del día, seleccionados por medio de query o “Todos”  

 

IMSI: esto se utiliza para cuando existe más de 1 modem. Cada SIM tiene su IMSI Propio. 

• Tarjeta SIM IMSI – si tiene varios módems gsm, puede introducir los 15 dígitos de la IMSI (International 

Mobile Subscriber Identity) de la tarjeta SIM para limitar la consulta a una tarjeta en particular. Esta 

opción es útil para rastrear la cantidad de sms recibidos a través de cada tarjeta SIM. 

Outbox / Inbox :  Sección donde se visualizan los correos salientes y/o entrantes. 

To / From :  Nombre del Contacto 

Message: cuerpo del mensaje enviado 

Sent / Received:  Fecha de envío 

Status = OK SMS enviado con éxito  a la red de Telefonía, ERR = SMS sin éxito de envío. Las  causas más 

comunes son: SIM con saldo agotado, numeración incorrecta, fuerza de Señal baja  o problemas 

Tecnicos  en la red.  Si presiona con doble click sobre el registro puede ver mas detalle.  

Transaction Records query:  con esta herramienta puede hacer una selección con mas detalle de los 

registros almacenados.   

� Los datos seleccionados pueden ser exportados en formato TXT o bien HTML.  

 

Desde un record seleccionado puede hacer otras transacciones. 

Seleccionado el registro ( aplica para el Inbox como también para el Outbox) , con 1 click y después con 

el botón derecho del mouse obtendrá una imagen como esta: 



 
 

P
a

g
e
4

0
 

 

• Donde podrá Reenviar el SMS al remitente 

• Enviar copia del SMS a otro contacto 

• Borrar el registro. 

Si desea eliminar un bloque de registros puede utilizar la secuencia CTRL+click o bien Shift + Click  y 

después presionar botón derecho del Mouse. Y seleccionar Delete Records ( el sistema le pedirá la 

confirmación) 

        

 

 La eliminación de registros es permanente! Por favor, imprima una copia de los registros si desea 

tenerla como referencia. 

9. Backup Database / Restore Database: 
 

Backup DataBase. 

Herramienta para emitir una copia de seguridad de su aplicación, siga la secuencia File >  Backup 

Database.  Seleccione el directorio donde se depositara la copia.  
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Presione el botón Backup. 

  

Aparecerá un cuadro de diálogo “Copia de seguridad de base de datos realizada con éxito”. Una copia 

de la base de datos de Smart Talk será almacenada en una subcarpeta dentro de la carpeta de destino 

especificado anteriormente “Archivo de base de datos de Smart Talk DD-MM-AAAA”. El DD-MM-AAAA 

es la fecha en que se realiza la copia de seguridad. 

El nombre de la base de datos es la siguiente: 

 

 

Restore DataBase. 

Esta opción se utiliza para restaurar la base de datos.  (Archivo necesario MoCoMain.mdb) 

Aparecerá un cuadro de diálogo como se muestra a continuación. Seleccione la carpeta que contiene la 

base de datos que desea restaurar. La carpeta debe estar en el formato “Archivo de base de datos de 

Smart Talk DD-MM-AAAA”, donde DD-MM-AAAA es la fecha en que la base de datos está siendo 

restaurada. Utilice la secuencia File >  Restore Database.  Y  Seleccione el directorio donde se 

encuentra el file.  
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Presione OK  y luego Restore. 

Cierre la aplicación y re iníciela. 

 

 

10.  CONFIGURACIONES 

 

En esta sección se pueden parametrizar algunas opciones para el mejor desempeño de la aplicación. 

Puede llegar usando la secuencia Tools > Configuration Settings  o bien presionando el icono  

 

 

Con ello el sistema le mostrara la siguiente imagen: 

General:  

Display upon Startup 

Donde puede definir visualizar la aplicación en Pantalla Completa al inicio de inicializar la aplicación 
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Application Title: 

Le permite personalizar el nombre de la aplicación ( Eje: SU EMPRESA) debe cerrar y reiniciar la 

aplicación para que el cambio tome efecto.  

 

 

 

 

 

 

 

 

Address Book: 

• SI Habilita el Auto-Insert Area Code, cuando crea un nuevo contacto al Mobile Number se le 

antepondrá el numero ingresado.  (NO ES NECESARIO INGRESAR EL AREA ACODE)  
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Scheduler: 

Parámetros para visualización del Scheduler 
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Auto Response: 
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Appointment Book: 

 

 

• Enviar avisos SMS posteriores  ( Send Subsequent Reminders)  
 
Usuario puede determinar cómo desea que Smart Talk maneje los avisos posteriores:  
* enviar recordatorios posteriores aún si no tienen respuesta – Se enviarán recordatorios SMS 
posteriores independientemente si los destinatarios responden o no.  
* enviar recordatorios posteriores solamente a destinatarios confirmados – Se enviarán recordatorios 
SMS posteriores solamente a los destinatarios que confirmaron sus citas (manual o automáticamente)  
* no enviar recordatorios a destinatarios confirmados /cancelados – no se enviarán recordatorios SMS 

posteriores si los destinatarios 
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GSM Terminal 

 

Visualización  del Estado de la fuerza de Señal de la conexión a la Red GSM 

(Signal Strength) 

El porcentaje de la fuerza de Señal GSM,  es afectada por algunos factores tales como: Posición 
Geográfica, distancia a una Torre de Señal,  ubicación del modem en un sótano  o en una oficina con 
muchos muros de concreto etc.  Esto lo puede visualizar la secuencia Tools->Configuration Settings -
>GSM Terminal-> Signal Strength . ( Es un dato de referencia solamente, no se puede modificar) Para 
poder enviar una Campaña de forma NORMAL la fuerza de Señal deberá ser mayor a 14 (ideal 20 o 
mayor) Max 31. Cambie de ubicación del modem, para recibir una mejor señal. Este Dato se actualiza 
cada 30 segundos aproximadamente. 

Escala de Signal Strength (Fuerza de Señal)  
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Configuración especial para el envío de SMS con más de 160 Caracteres. 

 

Por default en la instalación de STPRO,  se configura para enviar SMS de hasta 160 Caracteres. Si desea 

enviar SMS con más de 160 Caracteres, necesita hacer el siguiente cambio. 

1. Cierre la aplicación STPRO 

2. En la ruta donde está instalado el Smart Talk PRO (Generalmente es C:\Program Files 

(x86)\SMART TALK LATIN AMERICA LLC\SmartTalk  (verificar que en el archivo EIM.INI 

contenga estos parámetros) SupportPDU=1, SupportConcat=1,TotalSubMsg=3) * puede 

editarlo con notepad. 

3. Grabe el archivo editado y re inicie la aplicación STPRO. 

 

Motor de búsqueda:    

Se identifica con el icono      

Smart Talk tiene un motor de búsqueda integrado que permite a los usuarios buscar contactos de 
acuerdo a sus campos individuales. El motor de búsqueda básicamente realiza un filtro  utilizando los 
siguientes 3 tipos:  
• Búsqueda de texto  
• Búsqueda de selección  
• Fecha de búsqueda  
 

a. Búsqueda de texto 

 

 
 

Es el tipo de búsqueda que puede realizarse en campos basado en texto. En esta categoría, el 
usuario puede realizar los siguientes tipos de búsqueda:  
• iniciar con – buscar cualquier registro con el que los valores comiencen con texto escrito en 

“parámetros”. En el ejemplo a continuación, la búsqueda recuperará todos los registros cuyo 

“nombre” comiencen con “D”. 
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• finalizar con – buscar cualquier registro con el que los valores terminen con texto escrito en 
“parámetros”.  
•contiene – buscar cualquier registro con el que los valores contengan el texto escrito en 
“parámetros”.  
• coincidencia exacta – busca cualquier registro con el que los valores coincidan exactamente 

con el texto escrito en “parámetros”. 

• mayor que – busca cualquier registro con el que los valores sean mayores que el texto escrito 

en “ parámetros ”.  

• menor que – busca cualquier registro con el que los valores sean menores que el texto escrito 

en “ parámetros ”.  

• mayor que (numérico) – busca cualquier registro con el que los valores sean mayores que el 

texto escrito en “ parámetros ”. En este caso, los valores se comparan si son números.  

• menor que (numérico) – busca cualquier registro con el que los valores sean menores que el 

texto escrito en “ parámetros ”. En este caso, los valores se comparan si son números.  

 
b. Buscar Selección 

 

 

Es el tipo de búsqueda que puede realizarse en los campos que contiene algunas opciones para 
ser seleccionadas. En esta categoría, el usuario puede realizar los siguientes tipos de búsqueda:  
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• incluir – buscar cualquier registro que tenga el valor como se muestra en la columna 

“parámetro”. Según el siguiente ejemplo, la búsqueda recuperará todos los registros que tiene 

el valor “masculino” como su “género”. 

 

• excluir – buscar cualquier registro que no tenga el valor como se muestra en la columna 
“parámetro”. Según el siguiente ejemplo, la búsqueda recuperará todos los registros que no  

tienen su género especificado como “masculino”.  

 

2.3 Búsqueda de fecha  

 

Es el tipo de búsqueda que puede realizarse en los campos que se almacenan como tipo de fecha. En 
esta categoría, el usuario puede realizar los siguientes tipos de búsqueda:  
• Es hoy – busca cualquier registro que tenga valores iguales a la fecha de hoy. No se requiere ningún 
parámetro para esta búsqueda.  
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• Dentro del mes actual – busca cualquier registro que tenga valores que estén dentro del mes actual. 
No se requiere ningún parámetro para esta búsqueda.  
• Dentro del mes próximo – busca cualquier registro que tenga valores que estén dentro del mes 
próximo. No se requiere ningún parámetro para esta búsqueda.  
• Número de meses antes de hoy – busca cualquier registro que tenga valores que sean X número de 
meses antes de la fecha de hoy. El valor de x es el número que ha introducido en “parámetro”.  
• Hoy es aniversario – busca cualquier registro que tenga el mismo valor de día y mes de la fecha de 

hoy. Puede utilizar esta búsqueda para recuperar registros de clientes que cumplen años hoy. No se 

requiere parámetro para esta búsqueda. • Este mes es aniversario – busca cualquier registro que tenga 

el mismo valor de mes de la fecha de hoy. Puede utilizar esta búsqueda para recuperar registros de 

clientes que cumplen años en el mes actual. No se requiere parámetro para esta búsqueda.  

• El mes próximo es aniversario – busca cualquier registro que tenga el mismo valor de mes que el mes 
siguiente a la fecha de hoy. Puede utilizar esta búsqueda para recuperar registros de clientes que 
cumplen años en el mes próximo. No se requiere parámetro para esta búsqueda.  
•número de años antes de hoy – busca cualquier registro que tenga el mismo valor de año que sea igual 
a X número de años antes de la fecha de hoy. El número de X es el valor especificado en la columna 
“parámetro”. En el siguiente ejemplo, la búsqueda recuperará todos los registros cuya “fecha de 
nacimiento” fue hace 30 años. Por lo tanto, se recuperarán todos los contactos que tienen 30 años de 
edad.  
 

 

La búsqueda también puede recuperar registros dentro de un intervalo de valores. En el siguiente 

ejemplo, la búsqueda recuperará todos registra cuya “fecha de nacimiento” está entre 30 a 35 años 

antes de la fecha de hoy. Por lo tanto, todos contactos que tienen entre 30 y 35 años de edad se 

recuperarán en esta búsqueda.  
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Seleccionar resultado de búsqueda  

 

 

 

Haciendo clic en “buscar”, los resultados de la búsqueda se mostrarán en la parte inferior del cuadro de 
diálogo. Allí tiene dos maneras de selección de los resultados:  
• Seleccionar todo – haciendo clic en “Todos”, serán seleccionados todos los registros dentro de los 
resultados de la búsqueda.  
• Contactos seleccionados – se pueden seleccionar algunos contactos dentro de los resultados de 

búsqueda presionando “CTRL” y clic sobre el nombre. Se resaltaran los nombres de los contactos 

seleccionados tal y como se muestra a continuación. Haga clic en “contactos seleccionados” para 

continuar con la selección.  
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CAPITULO 12 

Monitoreo de envío de SMS. 
 

Para poder ver el Status del envío de los SMS, puede dirigirse a Tools->Real-time traffic monitor.  En 

donde la aplicación le mostrara los números de teléfonos pendientes de enviar. Puede detener el envío 

presionando  y para continuar con el envío presione .  En la línea Queue 

Length le indica los SMS pendientes de envío.  

 


